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QGIS Project Configuration

Project Configuration: Settings > Options

These change
the default
settings for ALL
QGIS PROJECT
FILES
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QGIS is extremely customizable !
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Application Style, Fonts, Project File Behavior
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Environment Vanable for QGIS and Plugins

Feature Attributeb and Table: Data Source

\ector and Raster Rendering Behaviors

Default Colors

(Layer and Map Appearance

Identify and Measure Tool Settings

Defaults for Map Composer

Snapping and Digitizing Tool Settings

Raster and Pyramid Driver Options

Projection Information

Override Local Language Settings

Point to local WMS and cache settings
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QGIS Project Configuration QH
Project > Project properties

Sdt. iew Layer Sedings  Flugins Vecior Raste N Selection color; Project Path; Map Units, Precision
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QGIS Project Configuration: Panels, Toolbars, Plugins @W

QGls Advanced Digitizing
Layer Settings Plugins Vector Raster Data
U Turn them on and off by "= == = e Browser cootbare
M 4 New 3D Map View Ctrl+Shift+M r
g0|ng tO V|ew > PanEIS or ] panwan Browser (2) Advanced Digitizing Toolbar
Toolbars |3 o Cooreinats Capture v | Attributes Toobar
g . . | 5= Zeomout CikRle= gosirectview v | Data Source Manager Toolbar
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g | 3 zoom Ful Ctrl+Shift+F Layer Styling
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D I b . f : \7) | Zoom to Selection Ctrl+1 "f LE'!.I'EFS \l"r Label Toolbar
Toolbars are a grouping o | Log Messages v | Manage Layers Toolbar
tOOIS | B Owerview v | Map Navigation Toolbar
D P I T I b I b : eceretons ’ Ej Processing Toolbox ¥ |  Plugins Toolbar
aneils/ 100i1obars Can also be 0 Preview Mode b
Show Map Tips F!_ESLIHE Viewer \"‘r Project Ti ”:I
2 I ject Toolbar
- *; | New Bookmark... Ctrl+B 2
d d d e d/re move d by Il g ht L% | show Bookmarie T U | Search QM5 v | Raster Toolbar
q q e Refresh F5 .
clicking on the toolbar area Spatial Bookmarks v | Shape Digitizing Toolbar
@ show All Layers Ctrl+5hift-+J
Hide All Layers Ctrl+5hift+H Statiztics Snapping Toolbar
~ L how Selected Layers
:ide Silect:ZI L;yirs Tile Scale \'Ilr Yector Toolbar
TEREEs SRR _ Undo/Redo v | Web Toolbar
Panels 3
Toolbars 4
DAYLI HTI N Toggle Full Screen Mode Fi1
G G ? Toggle Panel Visibility Cirl+Tab
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QGIS Project Configuration: Panels, Toolbars, Plugins @W
Plugins:

e Plugins are addons that introduce new features or functions to QGIS

e Adding, removing, activating and deactivating of plugins are all done through Plugins >
Manage and Install Plugins...

e Implemented as either core or external plugins

e Core Plugins (Installed) are developed by the QGIS dev team and included in
distribution

e External Plugins (Get more) or 3rd Party Plugins are stored in external repositories and
maintained by authors

e Within the Plugin Manager under Settings, choose Check for updates on startup and
then the frequency to keep them up to date

\
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QGIS Project Configuration: Panels, Toolbars, Plugins @W
. 1
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Search
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- GRASS ol B ) ¥ &) DB Manager
ey @ ’- Not installed r-G Dxf2Shp Converter Here you
i X Py e *‘ N EEVIS Click on tr
Ll Y| de ools Click the ¢
! # Settings v W Gdalmools
il :L_J,L Georeferencer GDAL Youcanc
@ Globe
¥ LE; GPS Tools
# GRass

Useful Plugins to get you started (but they do not work with the latest version of QGIS! Use v.
2.18 instead):

® Group Stats Plugin gives you the ability to summarize data layers in tabular format

® Openlayers Plugin gives you access to open data layers to add as backdrops to your maps.

les i de OpenstreetMap, Google Maps, Bing Maps and more.

\
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QGIS Project Configuration: Panels, Toolbars, Plugins

2 Plugins | All47) N |
t Al | Q, search |

= GeoCoding I~ Al Piugins
= GeoDataFarm
% Geodesic Densifier On the left you see the list of all plugins available for
b Notimeaicd % Geomapfish Locator your QGIS, both installed and available for download.
[V]5p Geometry Checker Some plugins come with your QGI’S_ installatio_n while
e & Geoportal LU | most _of t_hem are made available via the plugin
& oAt repositones. . . .
* e i | | |Youcan temporanly enable or dl_sable a plugin. To
Invalid [ Geore _rencer enable or disable a plugin, click its checkbox or
i Groscience double-click its name...
Install from ZIP i Seoeaiiin Plugins showing in red are not loaded because there
i Gealrace is a problem. They are also listed on the 'Invalid' tab.
_ & Get WKT Click on the plugin name to see more details, or to
SSaeds = GISHWRF reinstall or uninstall this plugin.
= go2mapillary
= goZstreetview
[ 75 GPS Taols
8 SPEeament Inpinsr () Plugins | Install from ZIP J
| <l Group Stats
& HCMGIS _
% Highlighter e
= Hotlink
= Hotspot Analysis | : Installed If you are provided with a zip package containing a plugin to install, please select the file below and dick the Tnséad slugin button.

~ Ingrade all
@ HTP Geonrocessor Upgrade al

Please note for most users this function is not applicable, as the preferable way is to install pluging from a repository.

Not installed

New

ZIP file: | I:I

Invalid

Install plugin

Close | | Help
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QGIS Project Configuration: Panels, Toolbars, Plugins

Check for updates on startup

|Eve1'y tme QEIS starts r
Mote: If this function is enabled, GGIS will inform you whenewer a new plugin or plugin update is -// 1 1 / 1 /
. " available. Otherwise, fetching repositories will be performed during opening of the Plugin Manager https c plugl ns'qgls'org plugl ns
'\ Notinstaller window.
New w (| Show also experimental plugins

Mote: Experimental plugins are generally unsuitable for production use. These plugins are in early
Irvalid stages of development, and should be considered 'incomplete’ or 'proof of concept’ tools. QGIS
= does not recommend installing these plugins unless you intend to use them for testing purposes.

nstall from ZIP

b [ | show alsa deprecated plugins

Plugin repositories -

Status MNarne URL :

@ connected Repository plugin uffidale QGIS https:/ plugins. ggis. org/plugins/plugins. xml?qgis=3.2 @ LRI EE R J
Mame || |
URL Ihttp:// |
Parameters ?qgis=3.2
Authentication | | |C|ear | |Edit |

ot | e ] o

Enabled
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QGIS Project Configuration: Map Projections (SRS/CRS) @ W

Projections
(J No one's favorite part of GIS
J But a necessary part of it nonetheless

d Convert points on the 3-dimensional Earth (latitude and longitude) to x and y
coordinates on a 2-dimensional map
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- These circles are all the same size on the globe!
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QGIS Project Configuration @W
A spatial reference system (SRS) or coordinate reference system (CRS) is a
coordinate-based local, regional or global system used to locate geographical
entities. A spatial reference system defines a specific map projection, as well as
transformations between different spatial reference systems

Projected Coordinate systems: define locations on a flat model of the Earth

Two standard parallels define the map layout.
{ selected by mapmaker )
. e T
: o i
2 L

vl e
Areas equal to globe. ./
Deformation of hapes increases away from those parallels.

Albers projectic;r?'“‘ Mercator projection

Geographic Coordinate systems:
define locations on a spherical model of the Earth
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Project Configuration: CRS 1. Geographic Coordinate Systems: @p

e Defines Locations with Latitude/Longitude values

® Latitude runs north and south of the Equator (0° — 90° north and south)
® Longitude runs east and west of the Prime Meridian (0° - 180°)

® Prime Meridian is Greenwich

North Pole
o}

The World Geodetic System (WGS) is a
standard for use in cartography, geodesy,
and satellite navigation including GPS. It
comprises a standard coordinate system
for the Earth, a standard spheroidal
reference surface (the datum or reference
ellipsoid) for raw altitude data, and a
gravitational equipotential surface (the
geoid) that defines the nominal sea level.

-9 S
South Pole Prime Meridian ™

The latest revisi S 84 (also known as WGS 1984, EPSG:4326), established in 1984

»
RIVERS and last revised in 2004. WGS 84 is the re ordinate system used by the Global
Positioning System.




AL
Project Configuration: CRS 1. Geographic Coordinate Systems: 2l

—180°450°-120° -0’60 "-30° O° 307 €07 §0° 1207 1507 180"

At the equator, and only at the equator, the
distance represented by one line of longitude is
equal to the distance represented by one
i % e degree of latitude. As you move towards the
- B v e " | poles, the distance between lines of longitude
g VTSN Y 0 "\ . becomes progressively less, until, at the exact
location of the pole, all 360° of longitude are
-« represented by a single point.
"~ Using the geographic coordinate system, we
have a grid of lines dividing the earth into
squares that cover approximately 12363.365
Km? at the equator — a good start, but not very
useful for determining the location of anything
within that square. To be truly useful, a map
grid must be divided into small enough sections
so that they can be used to describe (with an
acceptable level of accuracy) the location of a
point on the map.
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Project Configuration: CRS 2. Projected Coordinate Systems: @ b
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There are global map projections, but most map projections are created and optimized to prOJect
smaller areas of the earth’s surface.

Map projections are never absolutely accurate representations of the spherical earth. They show
distortions of angular conformity, distance and area.
It is |mp055|ble to preserve all these characterlstlcs at the same time in a map projection.

Normal aspect Transverse aspect Oblique aspect

(Lambert's equal-area)

Azimuthal

(Gall's stereographic)

Cylindrical

Mercator projection
Although the linear scale is equal in all
directions around any point, thus preserving the
= shapes of small objects (making
DAYLIGHTi:IG : jection), the Mercator
<ot RIVERS projection distorts the size jects as the §
FOR CIVIC s - latitude increases from the Equator to the
poles, where the scale becomes infinite.

(Albers's equal-area)

Conic

("Lagrange")




How to change projection in QGIS (Reproject) € b
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() Save Vector Layer as... ‘ ? -

Format |ESR.I Shapefile v

File name | | I:l
Layer nam? |

CRS @G:Zﬁ%f& -MNADS3 [ UTM zone 4M -
>4

O EE—

Encoding UTF-8 s

["] ave only selected features
[ Add saved file to map

P Select fields to export and their export options

w Geometry

Q@

Select the coordinate reference system for the vector file, The data points will be transformed from the layer coordinate reference system.

.__
w

Fiter |
Albers equal area
—t coordinate system Recently used coordinate reference systems o
Transverse Mercator Coordinate Reference System Authority ID # | .
coordinate system =
Generated CRS {+proj=aea Hat_1=29.5 Hat_2=45.5 Hat_0=23 Hon_0=-96 +x_0=0 +y_0=0 +datum=MADS83 ... USER:100031
Latitude-longitude 84 = Generated CRS (+proj=lcc Hat_1=40.66666666666566 +at_2=41,03333333333333 Hat_0=40. 1665666666666... LUISER: 100030
coordinate system Monte Mario [ Italy zone 1 EPSG:3003
WGS 84 EPSG:4326 ]

*5R generato {+proj=tmerc +at_0=0 +lon_0=0,000000000000002 +k=0.2995 +x_0=1500000 +y_0=0 +ellps=in... USER:100001
* SR, generato (+proj=tmerc Hat_0=0 +on_0=9 +k=0.9396 +x_0=500000 +y_0=-4000000 +ellps=intl +towgsa4... USER:100000

EDS0 [ UTM zone 32N EPSG:23032 = B
< >
Layer> Save Vector Layer as > CRS |~ e
Coordinate Reference System Authority ID |~ Help
NADSE3 f UTM zone 23N EPSG:26923
EPSG: 26902
NADS3 / UTM zone 3N EPSG: 26903 ]
[NADS3 / UTM zone 4 ) EPSG:26004 .
W

< — ___{l T3

Selected CRS [NADB3 / UTM zone 4 |

& 4
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B Training event (C1) of Daylightir;g rive@

Extent: -162.00, 15,57, -155.99, 74.71
Proj4: +proj=utm +zone=4% +elps=GRS80 +towgsd4=0,0,0,0,0,0,0 +units=m
+no_defs




